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Please Note:

IBM's statements regarding its plans, directions, and intent are subject to
change or withdrawal at IBM's sole discretion. Information regarding
potential future products is intended to outline our general product direction
and it should not be relied on in making a purchasing decision.

The information mentioned regarding potential future products is not a
commitment, promise, or legal obligation to deliver any material, code or
functionality. Information about potential future products may not be
incorporated into any contract. The development, release, and timing of any
future features or functionality described for our products remains at our
sole discretion.
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Agenda

o The challenges of software development today

9 Agile application development for WebSphere

e Scenario and demo
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Complexity is the biggest challenge facing organizations today!

“Today’s complexity is only expected to rise, and more
than half of CEOs doubt their ability to manage it.”

IBM 2010 Global CEO Study: 1500 face-to-face interviews, Companies of all sizes across 60
countries, representing 33 industries.
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IT software-based applications continue to e
grow in size and complexity. G Foiuis e
Globally distributed teams, outsourcing and = == ]
dependencies lead to increased challenges A [l e :

in the timely launch of competitive products Rl i

and services. 'Ea%* IEE

Organizations struggle to balance agility and complexity.

It's not enough to manage development, the design process itself must become
more streamlined and efficient.
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Software Development That Supports IT Agility

v"More business solutions
v"More flexibility

v"More quality

v"More business value

=Software Development Must Deliver: | »,

Business

-yet-
v"Less risk

v Less costs

v"Less or flat resources

- e =)
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ALM is about connecting the disciplines

r

Project/Planning

Business
Drivers

lterations
Sign-off
Contract
Risk Assess

User
Involvement

Requirements

Use Cases « TDD
Nonfunctional » Build
Sign-off Man.agement
Contract * Static

. Analysis
Risk Assess . BVT
Threat Model

e Source

Test Management

Requirements

Development

» Pair

Validation

Programming/
Code Review

Continuous Learning and Feedback

.
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Defining what “Jazz” means

= Jazz is IBM’s initiative for improving collaboration across the software & systems
lifecycle
= This initiative consists of three elements:
» An open platform for lifecycle tool integration
» A transparent community working together to integrate and develop lifecycle tools
» A set of products that support the Jazz platform

An architecture for common lifecycle integration
patterns

Application frameworks, toolkits, and other helpers for
tool providers

Jazz.net — A place where stakeholders collaborate

Enables visibility & influence into the evolution of the
Jazz platform and products

Lifecycle tools that support the Jazz platform

©2011IBM Corpe
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Innovate
An ALM solution powered by Jazz

Rational solution for Collaborative Lifecycle Management

CREATE SOFTWARE

Real-time Planning, Lifecycle Traceability, Team Collaboration,
Development Intelligence, Continuous Process Improvement

Quality

Development, Change,
v Improve Quality

vIncrease Value
v Improve Predictability

Requirements

Management

v'Reduce Cost
v'Reduce Time to Delivery

*extensiony
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How can Development become more agile and efficient?

We need a proven and stable set We need to be able to track
of tools that can handle our and deliver project status to
entire development process all stakeholders

—~

Deploy Develop

Minimize the challenges moving the application Quickly deliver working software that
from development to production scales and integrates easily?

Collaborative

Development
Test, Analyze Reuse

Enable teams to build in quality and Manage work products and enable reuse

security, and ensure validation of business Appllcatlon Developer across different projects

requirements along the way

Teamwork

Get more visibility and accountability in the builds. Ensure Collaborate with geographically diverse teams to ensure
stable builds and that needed fixes get in. clear communication of joint goals
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Reviews and . Server Team
Approvals I U SCA OSGi instances W?] _I<
— ysica
Gather > Update > Review > A JSP EJB ——
Refine > Approve - Track > Dojo Scrich Portal WS Virtual
Deliver > Retire P Servlet JPA — |
\-
HTML &
s . N cssull [ ook J2c % ,
Planning Quality
Java and XML
N y
Iteration Plans I Test Plans Test Results
IDE Debug o . s ’
. . " Profiling data Analysis data
configuration | sessions 9 | y | Test Cases Test Scripts
Define process = Analyze Work ltems Change Sets Workspaces Builds N 't' S e S ’
requirements > Plan items > 7 7 ’ 7 an re rovision
Review > Prioritize > Approve > Acquire Install > Execute > Open
g Track > Conclude Provision = Configure IDE - Configure TE - Target build > work items > Assess > Exit )
~ Accept work item > Check-out > N~
Code - Build > Deploy > Test > Debug = Analyze > Profile >
\ Check-in > Approval > Deliver /

5 3 3
QM RM Build D/T Assets R/T Assets

repository l repository l repository l repository l repository l repository r repository . repository
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Agile Application Development for WebSphere

Rational Application Developer for WebSphere Software + Rational Team Concert
» Team productivity thru integration of WebSphere development into the application lifecycle

= Process guidance for WAS with agility
» Built-in customizable agile/scrum process
Work items\

ensures best practices for development and
maintenance of WAS applications.

= Efficient development thru collaboration
» Unified IDE for development for WAS an
Portal that lets you collaborate on day t

day development tasks.
= Real time, dynamic, transparent planning
» Plans fully integrated with execution:
Dashboard, views, charts and more improve
Reporting /

planning and predictability.

= Enhanced stakeholder participation
» Powerful web Ul for project leads,

members, customers and partners to

participate in WAS projects, track status,

communicate, submit work items, ...

SCM

Planning _
server

Builds

Rational Team Concert

-
1
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IBM Rational Team Concert for Agile Development
Software innovation through collaboration

= Collaborate in-context

» Integrated release planning and reporting, source
control, document collaboration, work item, build
management, chat and process guidance

= Streamline agile development
» Out-of-the-box agile process configurations
= Automate governance

» Assess project status and trends in real-time with
web-based dashboards, metrics and reporting

= Scale to the enterprise

» Supports teams ranging from a few to thousands WI!IS !!!‘! reaulme repo!mg

of developers and stakeholders chat documents Web 2.0 custom
: H dashboards automated data gathering
= Unify diverse teams EXTENSIBILITY Ecipse plugins SEIVices
» Supports J2EE, .NET, IBM i, System z, archltecture FREEDOM TO CREATE

co-existence with popular toolsets openandex,ens,b,e -
v Collaborate

2 z - v Automate
v Report
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Rational Application Developer - Enterprise Java development
from the web to services and beyond

B B
2nd Tier 3 Tier
= 4 REST stylcy i - IBM CICS
= = ' |\ Services 4= Transaction
e e : .- Server
~ Web
4 |

* IBM InfoSphere
DB2

JavaScript '
Dojo ‘ WebSphere Portal
Web A

* Oracle

P _ JSF A ~ WebSphere Application Server
Client
\ J Tomcat | | JBoss * IBM InfoSphere
i IMS
Portal Client o
. J S — - SAP
4 R Viach c WA N - PeopleSoft
. . ashup ommunity * Siebel
\ Rich Java Ul Client ) Center Edition
\_ J L J
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Innovate

Adopting Agile Development with Rational Team Concert
Team productivity increases of up to 50%
Team collaboration performance up 25%*

A S > NN
Manage Source Track Changes Harness the backlog Steer the
Ve using Plans and sprint with
Process Templates Dashboards

~
.

Code

Track Builds

— Quality of releases improves 12%*
— Project governance improvements of 12%
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Innovate
Collaborative Development with Rational Application
Developer and Rational Team Concert

= Deliver solutions for WAS and Portal at higher = Reduce cycle time to identify, reproduce,
investigate and fix problems in the code

quality and pace by tapping into the team

v

 Z

E =/ o - o
Deliver changes
and build

Develo '
g Unit test = Debug, Profile

g ''''''''' Gate delivery of code
: . on coverage results.
Transfer live deb.u'g sessions. - e
Exchange profiling data. :
Code RTC builds. Import results.

Open defects.

coverage
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Rational Team Concert integrated into the RAD / RSA shell

Develop in RAD and RSA

Work with your development artifacts in the oerspectives (Modeling, Java EE,

“Team Artifacts’ view

iMrEe Bl @  BEROENESETRESABRREGRE@® %0 8- Q- @6 Y |22 JavaEE
B T B R R RS R R b Eeklil
E‘_g Enterptise Explorer (‘i‘_‘g‘ Services r‘:é Team Artifacks 52 =0 r@ “classdisgram droc E2 =0 EE Outline (E\g My Work |3 .
My Filter {1 of 61 Team Areas selected) | Db e ) =] o =
=7 i | @ «Java Class, Entity, ... =2
BC_G Repository Connections wJavadl 1 G JPACounterEntit » My Open Wark Ikems By Priofty (5:33 PM) = (&
H 3 cjdaly@jazzdew.torolab.ibm. com rc) a"‘ﬁls ¥ i
D - lazz Project [jazzdev torolab.ibm.cam] IgF i [F4f =Id» primarykey : ...
=g Builds o walue :int 5 15
@ «Aroundinvokes» m... e setvalue () ——— 2
(3 Build Engines Unassigned Lo Medium High
@7 betaz.install.integration. jazz @ getvalue ()
o o il e @ setPrimarykey() * Event Log Euents (82 unresd) = (A
O continuous.install jazz.iso . © getPrimarykey () [8] Review and complete Javadoc for the process #
) o «Java Interface, Locabs . 5 .
g install.integration jazz ©l IC ‘I‘Iw Darin Swanson delivered 1606:¥Z0080529a to 'Pr
g install.milestone. maintenance I 1 Darin Swanson delivered 1382:v20080529a to 'Pr
E (ﬁj Plans | @ increment() | s /A Jlared Burns delivered 4 change sets to Process =%
([ 0.6 RC4 [development] @ getThevalue () + Team Load Install, current [0.6 RC4] = (&
E‘ rﬁ* %f" [dEVTIIU[DmTt] @ James Stuckey ~
S Tnslal 016 r o ork Estimated 3
L-_t.| -~ developrment «lava Interface, Remotes 1 #av“aa.”'m“&'i: Load: 0 f 14| +14h d:0%6
([, Reports f RemoteCounter @ an G Rajeev Skka
=L Streams I W . S : 7\‘ s
- K Install (Instal) @ increment(} = «PersistenceContexr... - Buid e
] Install Integration (Instal) @ getTheValue () @, increment () I T =
] Tnstall Integration 0.6M4 [Beta 2] (Install) @, getThevalue () g et e ah"”_ldag'a o s
Ml tnstall Inteqgration 0.6MS (Install) & cnnt\nunus.. o iy.stem.]azz A
(#--1] Install Integration 0.6M6 (Install) f‘ cont\nuous.lnsta”.]azz E
-1k Tnstall Integration 0.6RCZ [Beta 3] (Install) e e =
(5 work Ieems g conkinuous, jazzdey. examples. jazz
[ Faverites ﬁ cunt\nuuus.]azzdsv.%uuls.]azz =
- l(5 Feeds =
L1 My Repository Workspaces (Ej Problems 53 = Tasks] Properties | 4ik Servers] 8 Data source Explnrer] = Sn\ppets] Ca Annntatmns‘] i
= "}g s Team v 0 iterns
PR : \ Resource Path Locat... | Type
and work flows — Change sets, suspend and r _
resume Changeb _______________________________ | Manage your workload in the
Tanm.- - aoanteall and. SN W rk’
ream-wentrar-ana vty VWo

Workspace hosted on the Jazz server.

= views
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Debugging is a team sport

= RAD / RSA and RTC together let team members share debug sessions in real
time.

_ ———— . —weiari) WRE: The
_ation Server w7.0 ak localho.

M [localhosk: 7779] e 1487
saemon Thread [WebContainer 1] (Suspende. _ainer : 1] (Running)
TestVariables jsp lins 47

_TYestWariables(
_Testyariables( & Transfer to User
Serviet\Wrapper,
Serviet\Wrapper

#p y Do you want to accept debug session, WebSphere Application Server v7.0
\4) Iocahost, from Samantha Chan?

Enter user name (begin with a sp.

ServietWrapper: | Mary

Servlet\Wrapper M-atchlng users: (1 user Found) | o
WASISPExtensidl | Mary - ISP Team TeTContent-Type" CORtEnt="text/html, CHAL5et=CPiZBET
WASISPExtensid =MContent-Style-Type"” content="text/css">
CacheServlet ISP/ theme/Master. c55" cel="stylesheet” type="teaxt

W SiiebCankain “ERdpslsakles

RN RIRTRTTI III IIJ [l

W SWWebiConting

v
SR ‘sration

e
PR, e 5 ¥t

Ratlon?l

Rational
' Team COncert

JAZZ Team sERVER
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Code quality is a team sport

= Share code coverage information from automated tests
= Analyze and improve test coverage to maximize code quality

Code Coverage Report (Apr 26, 2010 11:44:54 AM) 2N %,

e Coverage Report

Coverage Summary

coverage report for 'StoreApp', generated Apr 26, 2010 11:44:54 AM B 4 - |@‘ @

lement * Coverage Covered Lines  Total Lines y ‘f I -
® T [StoreApp] com.ibm.storeapp.models.test [16% | 11 69 = i 5 i g B
e [SmreAﬁg] mm_ibm_smreag:mmls > e : public void addCustomer (Customer cusLComer)
_‘% StOLE-‘-JEVE 7 54 if (totalS5oFar >= customers.length) |{
‘41 Product.java r'.; 0 6 _ L
ERT) Parr.javaJ 0 8 incrementCapacity ()
= ) Customers.java 8 15 }l
= ¥ Customers BEH ] 8 15
;: : e oid : T i customers[totalSoFze+4] = customer:
= ustomer| 100% | - - =
Ratlonalm ' 3 5 for (int i = 0; i & 8ioi: Ba-t'pnal
Ap p"Gaﬁ*d" et EEE— . 5 |Lines 18 to 20: Covered| Application
Developer Developer
Rational Rational
Team Concert Team Concert
Developer Developer

JAZZ team seRVER

\
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Code coverage integration with RTC

= RTC Build details viewer extension — RAD and Web browser
» Show summary of code coverage statistics
» Additional Code Coverage tab to show detailed coverage statistics report

= Integrated work item search and creation

= |Import to local workspace for rich viewing in navigator and source views

S - 5 ] Customers.java
& Build StoreApp Project build w/ Code Coverage 20100421-1319 = P cove =59 Customers
o ® incrementCapacity() : void
uraton el aetore % Mane reported against this buld % gEtCUStDmErS(} : CLlStl:ll'I'IEr[] 1 DDD."ID
Start Time:  April 21, 2010 4:19:44 PM [E creats a new workitsm.
Completed: April 21, 2010 4:20:47 PM e e ﬂ: ':UStDITIE—'I’S{:l 100,
s v ANENN % addCustomer(Customer) @ void
C T Paul java !D!z o 3
. M Part, \2:1&;- o ]
Coverage; bype: 40%, method: 32% block: 19%, line: 20%: C— 7 14
Er— : 4
~Y 0% o 6
IUniik: @ | test, O Fsilures, O errors Build Histary: & buids / ’ 100% 1 1
Lags: 2logs. Tags: 5 mE% 3 3
Repository Workspace:  Build Stream Workspace Deletion alowed P -~ - cUs::m:rddacv”:‘D”‘E’(C”sm”‘e’) s zzﬂ’; : ;
Snapshat: Storefpp Project build wi Code Coverage 20100421-1319 ’ ’ 2
?Drk e ;".m‘: 40 /-.7 - thod: 32%, block: 19%, i 20% I ’
o o 40%, methed: 9%, Hlogks 197, e 2% -
-
Associated Release -

Released builds are available as choices in the work item “Found In® Field

-
] Create 3 release to assaciate with this buid CoOvera ge |

Qverview | Activiies | Compilation | JUnit | Downloads |Logs | Coverage |

Overview | Activities | Compilation | JUnit [Downloads [Logs | Coverage |
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Development Team _ eam Test Team Development Team
Europe China China North America North America
4 Consistent Server Configuration \ / Continuous Build N
As a developer in a team | need to replicate or As a developer in a team | need to
get rapid access to my colleagues’ application continuously integrate my changes with those
server configurations to achieve and maintain of my colleagues, and initiate, monitor and
consistent development environments with reuse builds.
\_ minimum effort. J \_ /

...Improve individual and team productivity...

) / Continuous Build

Build the milestone code from work items that
have been checked into the repository.

\

[ Consistent Server Configuration

Developers can easily share or alter server
configurations on their desktop to drive

repeatability and automation when using the Notification of the build results and content
this platform. are available to any stakeholder requesting
\ J @at information. .

-~ B

JAZZ TEaMm SERVER
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www.ibm.com/software/rational
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www.ibm.com/software/rational
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